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Instructor notes

Introduction
The Adobe® Creative Suite® 6 Design & Web Premium Classroom in a Book® course 
presents students with tips, techniques, and solutions for using Adobe Creative 
Suite 6 Design & Web Premium. These Instructor Notes are intended to comple-
ment the information in the Adobe Creative Suite 6 Design & Web Premium 
Classroom in a Book.

The information is organized to follow the sequence of instruction in each lesson. 
However, the notes are not intended to expand on each and every exercise but 
rather to point out potential teaching opportunities not specifically covered in the 
lesson or areas where students might easily be confused.

About the workbooks
It is recommended that each student in the class have a copy of the Adobe Creative 
Suite 6 Design & Web Premium Classroom in a Book. Students will use this book as 
you lead them through projects. The book can also be used as a self-paced tutorial.

Before beginning a lesson, encourage students to browse through it, read any side-
bars, and refer to Help resources where appropriate.

You can buy more copies of the Adobe Creative Suite 6 Design & Web Premium 
Classroom in a Book for your students, or you can refer them to a bookseller to 
purchase the book.

Course strategy and scheduling
The book begins with the section “Getting Started,” which includes instructions 
for installation of Creative Suite 6 Design & Web Premium and for copying and 
organizing the files that will be used for the lessons and exercises. The chapter also 
contains information about additional resources and help.

Most of the book is made up of 9 lessons including exercises to help familiarize 
your students with Adobe Creative Suite by practical experience with the separate 
applications. You can teach approximately one chapter per session but—depending 
on the number and duration of sessions in your class—you may wish to combine 
related exercises from some of the shorter lessons, or split up some of the more 
involved lessons. To this end, you should make your own assessment of the com-
plexity of the exercises in each lesson. Some non-essential exercises—and exercises 
requiring Internet access, where that is not available in class—may be best assigned 
as follow-up work to be completed at home. In any case it would be helpful for your 
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students to have an idea of the various applications by having read the first part of 
the book as preparation.

The following lesson summaries may help you in structuring your course:

•	 Getting Started covers installation of the application software, setting up for 
the lessons by copying the image files used in the exercises from the application 
DVD into a lessons folder, creating a work folder for files created during the 
lessons, and creating a catalog file for the lesson images. The lesson files are 
imported into the catalog and the issue of reconnecting missing files to the 
catalog is discussed.

	 In a classroom situation this section is best combined with Lesson 1, so that your 
students already have an established catalog containing images when they begin 
to explore the interface and workspace modules.

•	 Adobe Creative Suite 6 Design & Web Premium provides an overview of the 
software. This section is divided into the following themes:

•	 The ultimate design toolkit for creative freedom and precise control

•	 Keep pace with today’s media

•	 The Adobe Creative Suite 6 Family

Although students may be aware of one or more of the applications in Adobe 
Creative Suite, many are not familiar with all of the applications, the purpose 
and functions of each application, and why there are multiple versions of 
the Adobe Creative Suite. Part 1 is intended to help identify the role of each 
application and its capabilities, place them within the context of Adobe Creative 
Suite workflows, and help students understand the differences between each 
version of the Adobe Creative Suite.

•	 Lesson 1 demonstrates important techniques in Adobe Bridge, Adobe 
Illustrator, and Adobe Photoshop by working through projects such as drawing 
in perspective in Illustrator and removing a background in Photoshop. Adobe 
Bridge serves as starting point for organizing the project. Some of the files the 
students prepare become assets for subsequent exercises in the book.

•	 Lesson 2 teaches how to speed up the process of designing a brochure for print. 
Adobe Bridge is used to start the lesson, and throughout the lesson Bridge and 
Mini Bridge play key roles in providing quick access to asset files at all times. 
Adobe Photoshop is used to prepare a raw format file from a digital camera so 
that it can be added to an InDesign layout. The later parts of the lesson teach 
several techniques for saving time during document production, as well as how 
to preflight and export an InDesign document for high-quality printing.

•	 Lesson 3 introduces students to new tools in Adobe Creative Suite 6 Design & 
Web Premium such as CSS Fluid Grids, JQuery Mobile, and PhoneGap Build 
that are intended to help web designers create sites that can easily address the 
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wide range of screen sizes, platforms, and devices that now display web content, 
such as smartphones and tablets. These tools aim to simplify web design by 
helping to relieve designers of the burden of developing multiple versions of a 
site, by making it possible to design a web layout that adapts to screen sizes, and 
by providing ways to automatically generate code and apps that work reliably on 
different platforms and devices.

•	 Lesson 4 takes a printed piece and adapts it into an online publication. Students 
use Adobe InDesign to create EPUB and iPad versions of a print document. 
Along the way they encounter the limitations of each format as well as some 
of the more likely adjustments that are necessary to adapt a print document to 
those formats, such as the creation of both vertical and horizontal layouts in a 
single InDesign document. Students also add interactive elements, and learn 
how to use Adobe Photoshop to create a video that can then be added to a tablet 
publication.

•	 Lesson 5 walks students through creating the Fluid Grid Layouts introduced in 
Lesson 3, and uses the resulting layout as a basis for previewing a web site on 
different screen sizes, and for steps that involve inspecting and editing CSS page 
elements. The last part of Lesson 5 focuses on integration between Fireworks 
and Dreamweaver projects.

•	 Lesson 6 teaches how to use InDesign to create an interactive PDF form. 
Students learn how to quickly lay out a form, add different types of buttons 
and interactive fields, format and customize form objects, and export to PDF 
in a way that preserves the interactive form features. The subject of this lesson 
doesn’t depend on other lessons in the book, so you can teach it at any time 
relative to the other lessons.

•	 Lesson 7 is another lesson that could be taught independently, as it deals with 
various ways to share work and collaborate online using Adobe PDF. This lesson 
gives detailed attention to Adobe Acrobat, which facilitates a range of review 
workflows. After a quick introduction to different types of review, the students 
will learn how to attach a PDF for an email based review and how to deal with 
comments, customize the appearance of document markup notes, collaborate 
in online meetings, and initiate a server-based, shared review. They will also get 
an overview of tracking and managing PDF reviews, and the possibilities for 
protecting work.

Some of the exercises may be best assigned as homework, as your students will 
need to have Internet access with their own valid email and Acrobat accounts. 

•	 Lesson 8 steps up a level from software-specific discussions to cover the 
more fundamental topic of preparing images for different media. The lesson 
is centered around concepts such as resolution, sharpening, and color; as well 
as adapting images to target media such as print, the web, and mobile devices. 
Because an image typically travels through multiple Adobe Creative Suite 
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applications before final output this lesson discusses image preparation in terms 
of different specific workflows such as print, and shows how a concept such as 
resolution can be inspected and edited in multiple Creative Suite applications 
such as Photoshop and InDesign.

•	 Lesson 9 tackles the challenging and often misunderstood topic of color 
management. As with Lesson 8, this lesson covers a subject that touches 
multiple Adobe Creative Suite applications in a typical production workflow, 
which means that it must be understood not only in terms of individual 
applications but how the applications in Adobe Creative Suite are integrated. 
Students learn about color modes, color spaces, color profiles, and how to 
inspect and edit those attributes in various Adobe Creative Suite applications. 
The last part of the lesson guides students through deciphering the options 
available for color management when working through multiple Adobe Creative 
Suite applications in a print workflow and a web workflow.

If your course time is limited, you may want to allocate your time using the lessons 
in the following ways:

•	 For beginner students, Lessons 1, 2, and 8 may be the most valuable.

•	 For students who primarily work in print, you may want to concentrate on 
Lessons 1, 2, 8, and 9.

•	 For students who primarily work on the web, you may want to concentrate on 
Lessons 1, 3, 5, 6, 8, and 9.

•	 Lessons 6 and 7 tend to be more useful for students working in large workgroups 
such as corporate settings.

•	 Lesson 9 may be considered an advanced topic, so it could be reasonable to omit 
it from a beginner-level course.

New features in Adobe Creative Suite 6 Design & Web Premium
The exercises from the lessons help students to become familiar with some of the 
new features they will encounter:

•	 Lesson 1 introduces Image Trace and the Pattern Options panel in Adobe 
Illustrator. In Adobe Photoshop, students also learn about the Tilt-Shift blur 
(one of the new Blur Tools), as well as the Content-Aware Move feature that not 
only blends new content into surroundings, but also fills in the area from which 
the content was moved.

•	 Lesson 2 covers an Adobe InDesign print workflow. The workflow steps in this 
lesson are essentially unchanged from Adobe InDesign CS5, so new CS6 features 
are not covered.

•	 Lesson 3 is an overview of recent Adobe Dreamweaver enhancements that help 
web designers accommodate multiple screen sizes, platforms, and devices more 
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easily, so the features covered—CSS Fluid Grids, JQuery Mobile, and PhoneGap 
Build—are all new in Adobe Creative Suite 6 Design & Web Premium.

•	 Lesson 4 is largely involved with new features in Adobe InDesign, as support 
for EPUB and iPad apps was significantly enhanced in Adobe InDesign CS6. 
In addition, many students may not be familiar with Adobe Digital Editions 
software used to view ebooks such as those in EPUB format.

•	 Lesson 5 goes into a more detailed, step-by-step tutorial of the new CSS Fluid 
Grid feature introduced in Lesson 3. The rest of the chapter covers features that 
existed in the CS5 versions of Dreamweaver and Fireworks.

•	 Lesson 6 covers tools in Adobe InDesign CS6 that make it easy to create forms 
with interactive objects, where the interactivity is preserved when the form is 
exported to PDF. The entire content of the lesson is new in CS6.

•	 Lesson 7 Your perspective on what is new in Lesson 7 depends on how you were 
teaching the Adobe Creative Suite 5 Design Premium Classroom in a Book. In 
that edition, Lesson 7 was Lesson 8 and covered Acrobat 9 Pro, because that 
version shipped with Adobe Creative Suite 5. Adobe then released Acrobat 
X Pro. If you have been teaching Acrobat 9 Pro, the steps in Lesson 7 in this 
book will be new to you because they cover Acrobat X Pro, which was released 
between Adobe Creative Suite 5 and 6 and ships with Creative Suite 6.

•	 Lesson 8 covers features that are generally unchanged from Adobe Creative 
Suite 5; however, the steps for cropping in Photoshop CS6 involve the 
redesigned Crop tool.

•	 Lesson 9 covers features that are unchanged from Adobe Creative Suite 5.

For more information about new features in Adobe Creative Suite 6 Design & Web 
Premium, you can direct students to http://www.adobe.com/products/creativesuite/
design-web-premium/features.html, where the feature list can be filtered by new 
features for print and web designers coming from Creative Suite 5 or earlier.

Additional Resources
Adobe Creative Suite 6 Design & Web Premium benefits from a wide range of con-
stantly updated online support materials that you can use to supplement this book:

•	 Adobe TV located at http://tv.adobe.com/ is a great source of tutorial videos for 
Adobe Creative Suite Design & Web Premium, created by qualified instructors 
inside and outside Adobe. You can also search on an Adobe software title on 
http://youtube.com to find many tutorial videos created by users and trainers.

•	 Adobe Forums are located at http://forums.adobe.com and are a great place to 
discuss and address up-to-the-minute issues for any of the software in Adobe 
Creative Suite Design & Web Premium.
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•	 Adobe Community Help located at http://community.adobe.com/help/ gives 
students a web version of the online help installed with Adobe Creative Suite 
Design & Web Premium. The advantage of using Adobe Community Help is 
that the topics are constantly updated with references to additional information 
from the online community outside of Adobe, including articles and video 
demonstrations. In addition, Adobe Community Help is integrated with Adobe 
Forums, so that questions posted in Adobe Community Help are now answered 
by the active Adobe Forums community.

Getting Started
Before beginning Lesson 1, you should decide how to deal with the issues of 
software installation and the copying of lesson files from the Classroom in a Book 
CD to the students’ computers. You may wish to prepare Lessons folders for your 
students before the first lesson begins, or work this procedure into the beginning of 
Lesson 1, together with the creation of work folders and initial catalog files.

Note that the questions in this section are in addition to the questions that are 
already in the Classroom in a Book at the end of each lesson.

Lesson 1: Setting up Basic Assets
This lesson starts out with organizing the lesson files in Adobe Bridge, and then 
moves to refining a logo, creating a pattern, working with enhanced multiple art-
board features, and drawing in perspective in Adobe Illustrator; and using the back-
ground removal tools, new Crop tool, and Blur tools in Adobe Photoshop Extended.

Illustrator and Photoshop are used in this lesson to demonstrate how they can be 
used to prepare assets for larger projects in Adobe InDesign for print or table page 
layout, or for Adobe Dreamweaver for inclusion in web sites. Students will see these 
graphics used with InDesign and Dreamweaver in later lessons.

Before starting this lesson, it would be helpful if the students have read through the 
first part of the book, which provides an overview of Creative Suite 6 and its compo-
nents. It also highlights the versatile workflows for multiple media, the consistent 
user interface, and new features of the individual components. 

Goals for this lesson
The overall objective for Lesson 1 is to introduce your students to these important 
skills and concepts:

•	 They should be able to organize media files in Adobe Bridge.

•	 They should be able to paint in Illustrator using the Bristle Brush.
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•	 They should understand how to refine a vector graphic in Illustrator with the 
Blob Brush tool.

•	 They should be able to set up multiple artboards and draw and edit artwork in 
perspective in Illustrator.

•	 They should be able to use the Refine Edge and Content-Aware Fill features 
to remove a background in Photoshop, and use Content-Aware Move to 
recompose elements of a photographic image.

•	 They should be able to work with the new Blur tools in Photoshop.

Organizing your work with Bridge
Draw attention to the advantages of organizing media files in Bridge, where you can 
also edit a file’s metadata. Using Bridge to synchronize color management between 
Creative Suite 6 applications is another essential task before starting the actual work.

A useful discussion point is to talk about the ways in which Bridge can be a more 
versatile file manager than the standard OS desktop file managers, Windows 
Explorer and the Mac OS X Finder. For example, you can talk about how the Filter 
panel is a way of quickly finding files based on the metadata in them. If the class 
contains many photographers, you may want to spend more time examining the 
Metadata and Keywords panels. In the Metadata panel, you can point out special-
ized fields such as those for entering copyright information.

Creating artwork in Illustrator
It’s worthwhile pointing out the strengths of Illustrator for creating vector graphics 
and its advantages for producing logo designs, as opposed to using a pixel editor 
such as Photoshop. After that, you can begin with a general tour of the Illustrator 
workspace, which will help orient your students and allow them to get accustomed 
to Illustrator’s interface. In addition, this can be a starting point for recognizing 
how the interface is consistent with other Creative Suite 6 components, such as 
Photoshop in the following exercise. Image Trace (which replaces the CS5 feature 
LiveTrace) is important for its ability to capture and translate the spontaneity of a 
sketch into digital form.

If time allows, have the students explore more with Image Trace and with the Blob 
Brush, which makes an enjoyable exercise. Also it would be beneficial to have a 
closer look at the artwork libraries that are available at the bottom of the Window 
menu—including a vast array of patterns, symbols, buttons and drawings, all orga-
nized by theme.

Setting up multiple artboards
You may want to discuss the types of projects that can benefit from using multiple 
artboard in Illustrator, compared to using multiple pages in InDesign. For example, 
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multiple Illustrator artboards can be useful to try out design iterations or to group 
related pieces of a job (such as a business card, envelope, and stationery), while 
multiple pages in InDesign are better suited for long multi-page documents such as 
printed or online magazines, thanks to features such as automatic page numbering 
and automatic generation of table of contents and indexes.

Cropping a photo in Photoshop
The Crop tool in Photoshop CS6 is a significant reworking of the Crop tool in many 
previous versions of Photoshop. The new Crop tool contains features such as the 
ability to crop to an aspect ratio, which makes it easier to use in today’s non-print 
workflows such as web and video.

If your students have experience with earlier versions of the Crop tool, you may 
want to show them where various options have moved. For example, print designers 
are likely to wonder where to enter a resolution (ppi) value; you can show them that 
it moved to the Size & Resolution command that’s on the menu at the left end of the 
Options bar for the Crop tool.

If your students have experience with Adobe Photoshop Lightroom, you can 
point out how the Crop tool in Photoshop CS6 is now more consistent with the 
Lightroom crop tool.

Adding creative blur in Photoshop
The exercise involving the Blur Tools is a brief overview of the feature using Tilt-
Shift blur. You can extend the lesson to have students try out the other two kinds 
of blur in Blur Tools—Field Blur and Iris Blur. Field Blur creates opportunities for 
considerable experimentation because of the ability to place many blur pins on the 
image, providing students with a great amount of control over how the amount of 
blur varies at any point on the image.

Removing a background in Photoshop
Because the initial selection is loaded from a saved channel, you may want to cover 
how such a selection would be made in the first place. For example, you may want 
to perform a brief demonstration of the Quick Selection tool on the subjects in the 
Original layer of the Photoshop file.

Removing unwanted objects in Photoshop
You may want to point out that Content-Aware Fill is more effective when the 
deleted area was originally surrounded by a significant amount of appropriate 
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content. Content-aware fill may be less effective when the deleted area is next to 
content that should not be used to fill the space.

Questions
1	 In the Refine Edge dialog box in Photoshop, what does the Smart Radius  

option do?

2	 In the Refine Edge dialog box in Photoshop, what is the purpose of the 
Decontaminate Colors option?

3	 In Illustrator, what’s the difference between the Perspective Grid tool and the 
Perspective Selection tool? 

4 	 What are the advantages of working with multiple artboards?

5	 What is the difference between the inner solid lines and outer dashed lines in the 
Tilt-Shift Blur effect?

Answers
1	 The Smart Radius option automatically adjusts the selection edge to adapt to 

the varying quality of an edge, such as adapting from the hard edge of a jacket 
to the softer, wider selection edge needed for hair.

2	 The Decontaminate Colors option removes colors from the edge of a foreground 
image’s original background so that those colors don’t show up against the 
image’s new background.

3	 In Illustrator, the Perspective Grid tool lets you view and set up a perspective 
grid. The Perspective Selection tool lets you transform objects along a 
perspective plane, including the ability to convert objects into perspective by 
dragging them onto the perspective grid.

4	 In Illustrator you can create a single file containing up to 100 artboards of 
varying sizes and display them any way you want—overlapping, side by side, or 
stacked. This is very intuitive when working on a series of design variations or 
separate design iterations intended for different applications. Artboards can be 
saved, exported, and printed independently or together.

5	 The solid lines control where a blur transition starts, and the dashed lines 
control where the blur transition ends.
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Lesson 2: Creating a Print Layout
This lesson teaches how to efficiently create a printed brochure. Your students will 
work with a combination of new features in the CS6 versions of InDesign, Illustrator, 
and Photoshop.

Goals for this lesson
The objectives for Lesson 2 are to expose your students to the basic print workflow, 
including how to hand off an InDesign document as a print-ready PDF file.

•	 Your students should be comfortable using Bridge and Mini Bridge to preview 
and select files.

•	 They should be able to create a new document in InDesign and navigate through 
its pages.

•	 They should understand how to work with layer comps in Photoshop files.

•	 They should be able to make basic corrections to Camera Raw images.

•	 They should know how to import and format text, including how to apply 
paragraph styles.

•	 Students should be aware of transparency and be able to work with it.

•	 They should be able to export to PDF format.

Inspecting and selecting documents with Adobe Bridge
As in Lesson 1, where the students began by organizing their files in Bridge, this 
exercise encourages them to use Bridge to find files quickly before starting a project.

Modifying an InDesign document
This exercise helps students to become familiar with the InDesign workspace 
and best practices for efficient layout. You may want to point out the areas where 
InDesign saves time, such as the way paragraph styles are shortcuts for applying 
combinations of text formatting settings, or the technique for placing multiple 
images as a grid.

In addition to the page navigation buttons at the bottom left of the document 
window and the Pages panel covered in the lesson, you may also want to mention 
that the page navigation commands under the Layout menu, along with the fact that 
the keyboard shortcuts for page navigation are customizable in the Edit > Keyboard 
Shortcuts command.

You might point out that the Live Captions feature is designed to work most effi-
ciently when captions have already been entered into the Metadata panel in Bridge, 
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similar to how image metadata was entered into images near the beginning of 
Lesson 1.

Working with Camera Raw images
Adobe Camera Raw 7, the version included with Adobe Photoshop CS6, features 
completely rewritten raw processing controls in the Basic tab. If you extend this 
lesson with material you have used to teach previous versions of Adobe Camera 
Raw, be sure your materials have been revised to account for the changes in Adobe 
Camera Raw 7. In short, the addition of automatic highlight recovery means that 
Exposure and Contrast should be the first sliders to adjust, and the other sliders 
used only as needed to refine image detail at the extreme ends of the tonal range.

This lesson shows how to click the Save button to generate a Photoshop file directly 
from one image in Camera Raw, completely bypassing Photoshop. You may want 
to point out that if multiple images were selected in Adobe Bridge and opened 
in Camera Raw, clicking the Save button will export edited copies of all images 
selected in Camera Raw in a single batch, which can save time.

Applying paragraph styles
You may want to make sure your students understand the advantages of using para-
graph styles versus formatting text by directly applying fonts and options such as 
font size, bold style, or a bullet list. If students are unfamiliar with paragraph styles, 
explain how applying a named style means that they can update all instances of that 
named style throughout a long document at once. Then point out how the same 
time-saving concept extends to other styles in InDesign, such as character styles, 
object styles, and table styles.

Preparing for printing
Although this section touches only briefly on the printing process, it would be a 
good idea to spend some time explaining the challenges and solutions for produc-
ing the best print results. Some of the most important issues are mentioned, such as 
working with transparency, checking the resolution of linked images, performing a 
preflight check, and exporting to the appropriately sized PDF. You could extend this 
section by discussing how different inks and color systems, paper quality, and print-
ing processes affect a printing workflow.

Questions
1	 What can you do if you can’t seem to find certain menu items?

2	 What is the white balance in a raw format image?

3	 How can you create a Photoshop file from an image in Adobe Camera Raw 
without opening Photoshop?



14  Instructor Notes

4	 What is the name of the tool that you can drag to adjust the spacing between 
objects?

5	 In InDesign, which panel helps you visualize which objects with transparency 
effects will be affected at output?

6	 In InDesign, how can you define a preflight profile, and what parameters can you 
specify?

Answers
1	 Some Adobe Creative Suite applications, such as InDesign and Photoshop, let 

you customize the visibility of menu items. Selecting a predefined workspace 
may result in some menu items being hidden. If you can’t find the item you’re 
looking for in a particular menu, choose Show All Menu Items at the bottom of 
the menu, if available.

2	 White balance reflects the composition of the color components in the light 
source when an image was captured. The White Point is used as a calibration 
benchmark to correctly interpret and render the color information recorded by 
the camera’s sensors.

3	 In Adobe Camera Raw, click the Save button. In the Save Options dialog box, set 
the Format to Photoshop and then click the Save button there.

4	 You can drag the Gap tool to adjust the spacing between objects.

5	 The Flattener Preview panel helps you visualize which objects with transparency 
effects will be affected at output as a result of flattening.

6	 To define a preflight profile, you need to choose Define Profile from the Preflight 
panel menu or from the Preflight menu at the bottom of the document window. 
Then, click the New Preflight Profile icon, enter a name for the profile, and then 
click to select any combination of the following preflight settings: Links, Color, 
Text, Images and Objects, or Document. Click OK to close the dialog box and 
save all changes. Click OK to close the dialog box and save all changes.

Lesson 3: Designing for Mobile Devices
This lesson teaches how support for new technologies in Adobe Creative Suite 6 
Design & Web Premium can help streamline the task of developing a web site for 
multiple screen sizes, platforms, and devices.
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Goals for this lesson
The objectives for Lesson 3 are to familiarize your students with some of the major 
tools that were introduced in Adobe Creative Suite 6 Design & Web Premium for 
addressing the challenges of web development for mobile devices.

•	 Students should understand the concept of responsive web layouts, and how the 
CSS Fluid Grids in Dreamweaver CS6 help to achieve that goal.

•	 They should understand the advantages of using JQuery Mobile over creating 
user interfaces for mobile web sites from scratch.

•	 They should be aware of the advantages of using PhoneGap Build to generate 
versions of mobile apps for multiple platforms and devices.

About the topics in this lesson
For less technically oriented students, it can be useful to clarify the distinctions 
between the three types of tools covered in this lesson. CSS Fluid Grids simplify 
web page layout, JQuery Mobile simplifies the creation of user interface controls for 
mobile web sites, and PhoneGap Build simplifies customizing web app code for the 
wide range of mobile devices available today.

You might point out to your students that responsive layouts may not be appropri-
ate for all web sites. For example, when designing a site that depends heavily on ad 
revenue, particular attention must be paid to the width of ad images and where they 
will appear as a layout is reflowed.

Questions
1	 What are some of the ways web designers can benefit from using JQuery Mobile 

over JavaScript?

2	 In Dreamweaver CS6, which button lets you view code and layout side by side?

Answers
1	 The syntax of JQuery Mobile is closer to CSS than JavaScript, which can be 

an advantage for designers more familiar with CSS syntax. Some common 
functions can require fewer lines of code in JQuery Mobile, and the availability 
of JQuery Mobile plug-ins can reduce the need to write code from scratch.

2	 In Dreamweaver CS6, the Split button lets you view code and layout side by side.
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Lesson 4: Creating Mobile 
Versions of a Print Layout
This lesson teaches how to use Creative Suite 6 to start from a printed piece and 
convert it into a rich interactive media document that can be published online. This 
lesson also briefly outlines how to prepare a video in Photoshop CS6 that can then 
be imported into the interactive document.

Goals for this lesson
The objectives for Lesson 4 are to familiarize your students with the workflows for 
converting a print document to EPUB and iPad tablet formats, and with the anima-
tion and interactive media features in InDesign.

•	 Students should understand the tools involved in creating EPUB and iPad 
versions of a print publication.

•	 They should know how to edit movie files in Photoshop and export them in a 
format InDesign can import.

•	 Students should be able to use InDesign to animate objects on a page.

•	 They should know how to export to both EPUB and iPad tablet formats from 
InDesign.

EPUB documents versus iPad/tablet apps
Consider leading a discussion in which your students compare the advantages and 
disadvantages of the EPUB format against a tablet app format such as for the iPad. 
The students should recognize that  the EPUB format is similar to a word-process-
ing format such as RTF in that it’s designed primarily to display as a single column 
with very limited layout control, while tablet apps can support sophisticated page 
layouts with multiple columns and arbitrary positioning of objects on a page, in 
much the same way that PDF files support.

Adding metadata
You might point out to your students that properly entering metadata can make a 
document more search-friendly, so that it’s easier for readers to find your publica-
tion online.

Creating a video in Photoshop CS6
The question may come up as to why Photoshop is used as the video editor for this 
lesson. Creative Suite 6 Design & Web Premium does not include a standalone 
video editing component, but Photoshop provides just enough video editing ability 
to let you add graphics and otherwise enhance video for basic needs such as the title 
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added in this exercise. In fact, for titles, Photoshop is capable of higher typographic 
quality than most dedicated video editors.

The steps for creating a video are a brief overview of the video-editing capabilities 
in Photoshop. If you want to extend the lesson, you can have your students explore 
other aspects of Photoshop video editing such as adding transitions, rotating, fading, 
and zooming by using keyframes to animate layers in the Timeline panel.

Preparing an iPad app for distribution
Students should understand that creating an iPad app involves a bit more than sim-
ply generating a folio from InDesign.

•	 To put the finishing touches on a folio, log into http://digitalpublishing.acrobat.
com and use the Folio Producer. This can be done using a free Adobe ID.

•	 To publish an app requires a Single Edition or Professional Edition license. Either 
are paid subscriptions. At the time this book was published, a Single Edition 
license is planned to be included with an Adobe Creative Cloud subscription.

•	 To distribute an iPad app through the Apple App Store requires an account on 
the Apple App Store. This is a paid subscription.

Questions
1	 How can you include complex page layouts in an EPUB document?

2	 What setting lets you break apart spreads of pages that remain together even 
when Facing Pages has been turned off?

3	 What can you do with a document’s paragraph styles to ensure compatibility 
with the widest range of e-readers?

4	 How can you create both a horizontal and vertical page design for a tablet app?

5	 What feature can you use to preview interactivity in InDesign?

6	 What does the Content Collector tool do?

Answers
1	 To include a page layout that isn’t a simple single column, you can rasterize 

objects on a page into pixels using the Object Export Options dialog box.

2	 Choose Allow Document Pages to Shuffle from the Pages panel menu, and then 
click No when you’re asked if you want to maintain the number of pages in each 
spread.

3	 Choose Edit All Export Tags from the Paragraph Styles panel menu, and then 
map InDesign paragraph styles to HTML styles.

4	 Create primary and alternate layouts in InDesign.
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5	 Use the Folio Overlays panel to preview interactivity in InDesign.

6	 The Content Collector tool, together with the Conveyor, makes it easy to transfer 
objects from a primary layout to an alternate layout, and also to link them so 
that you only have to edit one instance of an object and have the change appear 
in both layouts.

Lesson 5: Building a Website
This lesson teaches some of the tools and techniques available for building modern 
web sites in Adobe Creative Suite 6 Design & Web Premium. Students have an 
opportunity to use Adobe Dreamweaver to build the Fluid Grid layouts introduced 
in Lesson 3, preview a website on multiple screen sizes, inspect and edit CSS page 
elements, and explore the tight integration between Dreamweaver and Adobe 
Fireworks.

Goals for this lesson
The objective of this lesson is to introduce students to the approaches used to build 
web sites today, and the ways in which in Adobe Creative Suite 6 Design & Web 
Premium supports them, especially if students’ previous web design experience was 
centered around only HTML instead of CSS, and targeting a single desktop screen 
size rather than providing flexibility for a range of screen sizes across desktop and 
mobile devices.

•	 Students should understand how to start and edit a fluid grid layout that’s based 
on columns and div layers.

•	 They should know how to preview a web page using the Resolution Switcher, 
Preview in Browser, and Multiscreen Preview features.

•	 They should understand how to inspect and edit CSS page elements.

•	 They should know how to take a web page design from Fireworks and integrate 
it into a Dreamweaver web site using a roundtrip workflow.

Designing responsive web pages using a fluid grid layout
Creating a new web site and web page from a template in Dreamweaver can take 
several steps through multiple windows. Keep an eye out for students who may miss 
one of the steps required to arrive at the correct dialog box.

Adding the div layers can be tricky. Students should pay particular attention to the 
placement of the cursor before adding another div layer. You may want to demon-
strate how the layout results differ when the cursor is placed in a different position 
in the code.
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Inspecting and editing CSS page elements
When working with CSS elements, it’s often necessary to watch multiple parts of 
the document window at once. Students may need to keep an eye on the Design 
view to ensure that the correct element is selected, the CSS Styles panel to ensure 
that the correct CSS style is selected for editing, and the Properties panel for any 
HTML formatting also applied to an element, and the Code view if necessary to 
verify the effect of an edit on the page code.

If students can’t locate the correct CSS style name to edit, have them double-check 
to make sure the All tab is selected in the CSS Styles panel, and also have them 
enlarge and scroll the CSS Styles panel so that the style headings are visible—it may 
not be evident at first that the list of CSS styles is hierarchical if the headings are out 
of view.

Including Fireworks HTML pages in Dreamweaver
The Fireworks PNG document used for this lesson doesn’t include interactivity, but 
if you want to extend the lesson, you could lead students through using Fireworks to 
add hyperlinks to the slices in the Fireworks PNG document.

Students may not be aware that the PNG format can store more than graphics data. 
PNG serves as the format for Fireworks documents because it can store data for the 
features in Fireworks in addition to the image itself.

Questions
1	 What is a div layer?

2	 What is a limitation of the Live view in Dreamweaver?

3	 What step is required before integrating a Fireworks web page design into a 
Dreamweaver web site?

Answers
1	 A div layer is a CSS element on a web page. It can contain content such as text, a 

graphic, or interactive multimedia.

2	 Live view simulates how web pages look in a WebKit-based browser. This means 
it may less accurately simulate how web pages look in browsers that use a 
different web page rendering engine.

3	 The Fireworks web page must be exported to HTML before being imported into 
a Dreamweaver web site.
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Lesson 6: Creating Interactive Forms
This lesson covers the ability to create forms in Adobe InDesign that can be 
exported as fully interactive PDF forms. This capability is new in InDesign CS6, 
significantly improving on the CS5 workflow where forms could be designed in 
InDesign, but the interactivity could be added only in Acrobat. Now both form 
design and interactivity can be built and refined completely within InDesign CS6, 
except for the coding at the web server that is required to process incoming forms.

Goals for this lesson
The objective of this lesson is to teach students how to use the tools in InDesign 
to lay out a form, add different types of form objects, format them, and export the 
finished form as a PDF file.

•	 Students should understand how to use a table as a framework for form layout.

•	 They should understand the intended uses of form objects such as radio buttons, 
check boxes, and combo boxes in the context of data collection.

•	 They should know how to use the built-in library of pre-designed form objects in 
the Sample Buttons and Forms panel.

•	 They should be able to properly configure the Export command so that it 
generates a PDF file that is a functional interactive form.

•	 They should know how to use Acrobat to test interactive forms.

Creating PDF forms in Adobe InDesign
You might remind students of the great advantage of designing forms completely 
within InDesign. While forms applications exist, most have very limited tools for 
design and typography. Using InDesign, students have access to extremely precise 
layout tools and sophisticated typography tools, which together can help students 
produce forms which can differentiate them from other form designers. PDF forms 
can also be more visually appealing for printing and manual entry than those cre-
ated with more utilitarian forms software.

As an alternative to laying out a form with a table, you can also suggest laying out 
form objects along ruler guides or the page grid, or using the Align panel to make 
objects line up.

Using the Sample Buttons and Forms panel
When students test their forms later on, you may want to point out how the mul-
tiple states for the sample buttons switch in and out as students interact with the 
form objects.
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Checking your work so far
You might demonstrate opening an InDesign-generated PDF form in other PDF 
readers, such as Apple Preview or an old version of Adobe Reader/Acrobat Reader, 
to show how a PDF form may have less functionality when not viewed in the latest 
version of Adobe Reader or Adobe Acrobat.

Adding text fields
If you want to extend the lesson, you can go over the many options in the Buttons 
and Forms panel that are not covered in this lesson, particularly the choices in the 
Event and Actions options and the states in the Appearance option.

One aspect that is not evident in the screen shots is that when a form field is large 
enough, there is a form field indicator in the bottom right corner of a field. Students 
may see this indicator when they zoom in on form fields, or on larger monitors 
where the page may be displayed at a higher magnification.

Questions
1	 How do you change the size and position of a form object?

2	 How can you help ensure that text in a form field fills the field?

Answers
1	 You can edit the size and position of a form objects using the same InDesign 

tools you would use for other InDesign graphics: Edit visually by dragging object 
handles, or edit precisely using the Control Panel.

2	 Select the form object, and then in the Buttons and Forms panel, set the Font 
Size to Auto.

Lesson 7: Submitting Work for a PDF Review
This lesson introduces different kinds of online sharing and collaboration. Students 
can get to know about email-based reviews—including how to add comments, mark 
up documents, and customize notes. Additionally they’ll learn in more detail how 
to set up an online meeting using ConnectNow and Share My Screen. Since the 
classroom situation sometimes does not allow for Internet access so that students 
can set up their free Acrobat.com accounts, some of these exercises might be better 
assigned as follow-up work to be completed at home.

 Note:  Acrobat X Pro, included with Adobe Creative Suite 6, has a much different user interface 
than Acrobat 9 Pro. If you’ve been teaching Acrobat 9 Pro, pay careful attention to the changes in 
Acrobat X Pro because they significantly change how you conduct PDF reviews.
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Goals for this lesson
The overall objective for Lesson 7 is to expose your students to different options for 
online sharing and collaboration.

•	 Students should know the difference between an email-based review, a shared 
review, and an online, real-time review.

•	 They should be able to attach a PDF for email based review.

•	 They should know how to add and reply to comments.

•	 They should be able to mark up documents and personalize the appearance of 
notes.

• 	 They should have an idea how to initiate and collaborate in an online meeting.

•	 They should be able to track and manage a PDF review.

•	 They should be aware of the different ways to protect work.

Collaborating in an email-based review
After a short introduction to the three different kind of reviews (the email-based 
review, the shared review, and the online, real-time review), your students will 
begin by attaching a PDF to an email. For the classroom, the process of conducting 
the review will be simplified so that students can become familiar with the relevant 
features and tools in Acrobat, despite the fact that they might not have access to a 
shared server or a remote partner to participate in the review.

You may want to be the one who initiates the review, or you can have specific stu-
dents initiate reviews that other students respond to.

Managing reviews
In some classrooms, Internet access may not be available. However, your students 
can still explore the Tracker, and understand how to initiate a shared review and the 
simpler approval workflow. These exercises might be better completed or repeated 
at home. If your students have Internet access at home, you may even want to run 
a homework assignment that involves having the students interact with a docu-
ment you make available for review online such as one hosted on Acrobat.com, and 
conduct the entire simulated review outside the classroom when the students are 
dispersed in many locations.

Collaborating in online meetings
This exercise steps through the workflow for an online meeting using ConnectNow 
with the Share My Screen feature. Again, should the classroom situation not allow 
for full Internet access the exercises can be completed at home.

 Note:  Up to three people, including the host, can attend a ConnectNow meeting at one time.
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Questions
1	 What are five things to do in case you encounter difficulties setting up or 

attending an online meeting?

2	 What is ConnectNow? 

3 	 What are the advantages of the real-time online meeting?

Answers
1	 Following this check list might help avoid such problems:

•	 Ensure that you are connected to the Internet.

•	 Check that your software and hardware meet the system requirements, 
particularly the version of Adobe Flash Player.  
For a complete list, see http://www.adobe.com/acom/systemreqs/.

•	 Disable any pop-up blocker software.

•	 Clear the browser cache.

•	 Try connecting from another computer.

•	 Ensure that you have entered the correct URL.

•	 Try joining the meeting as a registered user or as guest.

•	 Confirm that you are using the correct password.

2	 Adobe ConnectNow is a personal web-conference tool that you can use to 
conduct real-time meetings—sharing a document or your entire desktop, and 
using live chat, online whiteboards, and other collaborative features. As an 
attendee you join the meeting by logging in to a web-based meeting space from 
your own computer.

3	 Such online meetings offer the advantage that everybody has exactly the 
same view of the document being discussed—which is set up by the person 
conducting the meeting. The initiator has complete control of what the clients or 
colleagues are seeing while walking them through the project.

Lesson 8: Preparing Images 
for Different Media
This lesson teaches fundamental concepts that apply to images that pass through 
multiple Adobe Creative Suite Design & Web Premium applications in both print 
and web workflows. Resolution, sharpening, and image color are considered within 
both workflows; the lesson leads students through a complete set of print workflow 
steps and then through a complete set of web workflow steps.
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Goals for this lesson
The overall objective for Lesson 8 is to help students understand that the same set 
of image specifications can have very different values depending on the intended 
output medium, and then demonstrate how to implement typical image specifica-
tions for both print and web workflows.

•	 Students should understand the multiple meanings of the term resolution, and 
how to evaluate and alter resolution correctly for their specific workflow.

•	 They should understand typical sharpening settings for print and web workflows,  
and know the typical points in the workflow and methods for sharpening that 
are appropriate for each workflow.

•	 They should understand the standard color modes for print and web workflows, 
and how to specify and convert color correctly for their specific workflow.

Image resolution and media
It is possible that your students may debate the effect of image resizing on resolu-
tion, disagreeing on points such as whether changing resolution changes file size or 
whether ppi matters for on-screen images. If you find yourself moderating discus-
sions about resolution and resizing, be sure to take into account whether resampling 
is applied (such as the Resample option in the Image Size dialog box in Photoshop), 
because that option affects the results. In fact, using the Image Size dialog box as 
a resolution calculator can be an effective way of demonstrating to your students 
exactly which variables are involved in the relationship between pixel density and 
image dimensions.

Preparing graphics for the web and mobile devices
This section demonstrates two ways to save web versions of an image: the Save 
button in Camera Raw, and the Save for Web command in Photoshop. You may 
want to have students compare and contrast when one of those methods might be 
better than the other. For example, when browsing images in Adobe Bridge the Save 
button in Camera Raw makes it possible to avoid launching the entire Photoshop 
application just to perform a simple conversion.

Another possible discussion to have is comparing the Smart Sharpen filter to the 
older and simpler Unsharp Mask filter that students may be more familiar with. You 
can discuss the advantages of the Smart Sharpen filter, such as the way the Lens 
Blur options engineered to minimize halos, and the Advanced options.

Preparing graphics for print
You may want to have the students review and discuss the differences between 
preparing an image for the web and for a press. Have the students focus on the 
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differences in color mode, resolution, and sharpening. With sharpening in particu-
lar, note how high-resolution images require more sharpening than low-resolution 
images. On the subject of color for print, note that previewing how the colors actu-
ally look when printed is done by the soft-proofing feature covered in Lesson 9.

Questions
1	 How can you determine the number of megapixels of an image?

2	 Why are printed images not saved at the resolution of the printer?

3	 What are the color modes used by web sites and printing presses?

4	 What is the difference between a color mode and a color space?

5	 In Adobe Camera Raw, how do you specify the ppi value that an image will have 
when it leaves Camera Raw?

6	 How can you save a crop size you frequently use in Photoshop?

Answers
1	 Simply multiply the height and width of an image, in pixels, and then divide the 

result by one million.

2	 Printers use processes such as halftoning and dithering to mix printer dots 
to build up larger cells or areas of color, so saving an image at the full printer 
resolution is not necessary and would create an unnecessarily large file.

3	 Web site graphics use the RGB color mode, while printing presses use the CMYK 
color mode.

4	 A color mode is defined by the types of primary colors it uses (such as RGB vs 
CMYK). A color space is a specific range or gamut of color within a color mode, 
usually referring to the color range a particular device can reproduce.

5	 Click the underlined text at the bottom of the Camera Raw dialog box to open 
the Workflow Option dialog box, which contains a Resolution option.

6	 In Photoshop, you can save a frequently used crop size as a Crop tool preset.

Lesson 9: Managing Color Across 
Adobe Creative Suite
Color management is built into nearly all Adobe Creative Suite 6 Design & Web 
Premium applications, but is often a challenging topic for designers to understand, 
especially when multiple applications are involved. This lesson presents an intro-
duction to the basics of color management and how it’s implemented in Adobe 
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applications, first within Photoshop and then across examples of typical print and 
web workflows.

Goals for this lesson
The objectives for Lesson 9 are to familiarize students with the fundamentals of 
color management so that they understand how to make choices when using color 
management features in Adobe Creative Suite 6 Design & Web Premium.

•	 Students should understand and distinguish color modes, color spaces, and color 
profiles.

•	 They should be able to understand the differences between different types of 
color profiles, such as the document profile, working space, and output profile.

•	 They should know how to choose a color preset in the Color Settings dialog 
box that appears in several Adobe applications, and how to synchronize color 
settings in Adobe Bridge.

•	 They should be able to describe the difference between assigning a color profile, 
converting to a profile, and embedding a profile.

•	 Students should know how to inspect and alter a document’s color management 
settings in Adobe Photoshop and Adobe InDesign. In Adobe InDesign, they 
should also know how to inspect and alter the color management settings for 
individual graphics in an InDesign document.

•	 They should understand how to set the proper color management settings for a 
print job in Adobe Photoshop or Adobe InDesign.

•	 They should know how to soft-proof a document in Adobe Photoshop, to 
simulate how image colors will look under specific output conditions.

Understanding color management
Make sure your students understand that color management and color correction 
are different things. Color management provides a reliable environment to evalu-
ate images and perform color corrections. One way to explain the value of color 
management is to say that a color-corrected image will look incorrect if a system 
isn’t properly color managed. Similarly, if a system isn’t color-managed, you’ll never 
really know (on a monitor) when an image is properly corrected.

The complexity of color management causes some to look for a way to turn it off. 
Students should understand that professional graphics applications (especially 
those from Adobe) and current desktop operating systems generally have color 
management on with no way to turn it off. Therefore, it’s better to understand color 
management than to try and avoid it.
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You can extend this part of the lesson by demonstrating the use of a hardware color 
calibrator, and showing where the color profile that it produces appears in the oper-
ating system (for example, in the operating system’s Display settings).

Choosing a Color Settings preset
Students should understand that choosing or synchronizing color settings doesn’t 
alter existing image files. Because color settings are defaults, choosing a color 
settings preset merely changes default profiles (working spaces) and the policies 
for handling color mismatches or missing profiles. For images without embedded 
profiles, the reason colors may appear different after changing color settings is not 
because the image files are changed; what’s changed is how the files are displayed 
(which profile is used to display them). In other words, for untagged files, the effect 
of changing Color Settings preset is similar to using the Assign Profile command 
covered in the next section.

Converting to, assigning, and embedding profiles
If your students find the subject of this topic to be confusing, try these additional 
explanations:

•	 When an image must be in a different color space because it’s required by the 
workflow (such as converting to CMYK for press output), use Convert to Profile. 
Convert to Profile uses a profile to change the actual color values of the image.

•	 When an image has no profile or the wrong profile and so you want it to 
be edited using the correct color space, use Assign to Profile. Assign to 
Profile never changes color values, only how the values are interpreted (the 
interpretation is dictated by the profile).

•	 When an image is being edited in the correct color space but the profile for that 
color space isn’t attached to the image, embed the profile.

Setting up a color-managed print workflow
The issue of whether a printer is RGB-based or CMYK-based can be confusing 
because the system and applications such as InDesign see printers based on the 
color mode the printer driver is designed to receive, not by the inks they use. As 
described in the chapter, most desktop printers are set up to receive RGB data. But 
an important exception are printers set up to proof a CMYK press. For example, 
the standard driver software for popular photo-quality desktop printers is typically 
designed to receive RGB data; but if you install press proofing software it will typi-
cally expect CMYK data, which changes how you would set up the Print dialog box.

In the section about soft-proofing with the Proof Setup command in Photoshop, 
you can point out that the Proof Setup command is also available in InDesign and 
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Illustrator so that students can preview print colors more reliably in those applica-
tions as well. However, the most thorough implementation is in Photoshop.

Resolving color space mismatches
The most challenging part of resolving a color space mismatch is figuring out which 
profile should be applied. A useful question for students to ask is where the image in 
question came from, because that can provide a clue as to the color space in which 
the image was originally edited, and therefore which profile should be applied.

Questions
1	 Why is it necessary to calibrate a display using a hardware calibrator instead of 

using software that lets you calibrate by eye?

2	 Where do you synchronize color settings across Adobe Creative Suite 6 Design 
& Web Premium applications?

3	 How can you determine the color profiles of images when you’re looking 
through a folder in Adobe Bridge?

4	 What type of printer is typically RGB-based, and what type of printer is typically 
CMYK-based?

5	 If you have an image in an InDesign layout, how do you assign a different color 
profile to it?

6	 What are the two most common rendering intents that are used?

Answers
1	 Human color perception is so adaptive that it isn’t objective or precise enough to 

be reliable for visual calibration. A hardware calibrator is objective and precise.

2	 In Adobe Bridge, choose Edit > Creative Suite Color Settings.

3	 In Adobe Bridge, open the Metadata panel to see the Color Profile field.

4	 Desktop color printers typically receive RGB data, while prepress systems for 
printing presses typically receive CMYK data.

5	 In InDesign, select an image and choose Object > Image Color Settings.

6	 The Relative Colorimetric and Perceptual rendering intents are the two you’re 
more likely to use.


